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Introduction to SAS

Learning SAS:

1.
SAS is the most widely used statistical software package in the world.  Therefore, it is a good idea for you to learn it.

2.
There is a version of SAS on the PC’s in each of Carnegie Mellon’s clusters.

3.
The best way to learn to use SAS is to do the following:

a.
Go to a computer which has SAS for windows, start the program, look under the “Help” menu for “Online Training” and go carefully through the tutorial.  This will take several hours, so you should budget your time accordingly.

b.
Look carefully at all of the examples we do in class --- I include SAS programs with them.

c.
There is a help feature on this version of SAS.  Select “Extended Help” from the Help menu.  Then select the tab labeled contents.  Select the book labeled “SAS system help main menu”  From there, you can get help on a wide variety of things.  You can find descriptions of the procedures we will use in this course under “modeling and analysis tools” and then “data analysis” or under “modeling and analysis tools” and then “econometrics and time series”

Using SAS:

1.
SAS is a programming language, like FORTRAN or C.

2.
The way you will generally use SAS is:

i.
Write a SAS program

ii.
Submit the SAS program

iii.
Look at the results SAS generates, fix any “bugs”, and submit again

3.
On the PC’s in the computer clusters, you write the program in the “Program Editor” window.  You submit the program by pushing the submit button (looks like a guy running), on the toolbar just below the menu bar near the top of the window.  You examine the results in the LOG window (where SAS tells you about any errors which occurred) and in the OUTPUT window (where SAS tells you the results of your program.

Your data file:
1. Go to the web site for the course.  Navigate to the Datasets page.  There you will see some datasets listed.  Each dataset has a link for “zip file.”  (A “zip” file which was compressed using one of the programs Winzip or Pkzip). This is where the data are.  Click on the macro link under data file.  The internet browser should ask you whether you want to save or open the file.  Open it.  Now you should be in the program Winzip.  Tell Winzip to extract (uncompress) the data in macro by clicking on extract and then navigating to c:\temp, the temp folder on the hard drive.  Winzip will place the file macro.txt in the temp folder on the hard.  This file contains macroeconomic data for the United States from the first quarter of 1958 through the second quarter of 1992.  Each line in the data is one quarter’s worth of data.  The columns in the dataset are (in order left to right) year, quarter, GDP in billions of $, consumption expenditures in billions of $, investment expenditure in billions of $, net exports (exports - imports) in billions of $, government spending in billions of $, and the GNP deflator (a price index) equal to 100 in 1987.  Please take a look at the file, either with Microsoft Word or a text editor (just double-click on the file). (be sure to use Courier font or Courier New to look at the data)   Notice the dots for GDP in the early observations.  “.” Is SAS’s way of saying “missing” --- missing means that we don’t know the value of the variable for that particular observation.

2. Now go and take a look under the Codebook and Description links at the web site.  You will see the same descriptive information as in 1.  Typically, you will look on the website for descriptive information about the data.

3.  In the discussion to follow, we will go along through the program attached to this handout labeled “SAS EXAMPLE #1”

Parts of a SAS program:
1.
Initial few lines

In the first few lines, we tell SAS where to find the files which contain the data we are going to use for our analysis.  For example, the first line of a program might be:

      filename macroraw ‘c:\temp\macro.txt’;

This tells SAS that there is a file called macro.txt in the temp directory on the c drive of the computer and that we are assigning a “nickname” macroraw to it, so that, later on, we can just call the file macroraw instead of ‘c:\temp\macro.txt’

Notice that the command ends with a “;”  All SAS commands end with a “;”  Leaving the “;” off is the most common error in programming SAS, and SAS is very stupid about catching this mistake.  When you get goofy error messages (in the LOG window) always check for missing “;” first.

2.
Data step

The data step begins with a line like:

        data macro;

This tells SAS to create a dataset called macro.  The next few lines will tell SAS where to go to get the data that goes in the data step.  Often the next line will be:

          infile macroraw;

This line tells SAS that it is going to get the data from a file called macroraw (which we already told it where to find in 1. above).  Now SAS knows the data are in macroraw, but we still must tell it what the variables are and how they are arranged in the file:

input year 1-4  quarter 10

        Y 14-20   C 24-30  I 34-40

        XM 44-50  G 54-60  P 64-68;

This line tells SAS that the variables in the data file are named year, quarter, Y, C, I, XM, G, P.  It also tells SAS that the values for the variable year is stored in columns 1-4 in the file macroraw, that the values for the variable quarter are stored in column 10 in the file called macroraw, . . .  Notice, this command takes several lines --- that is OK, SAS does not look for carriage returns at the end of commands, it looks for “;”  You can stretch a command over as many lines as you want, as long as it ends eventually with a “;”

After these two lines, SAS reads in all the data from the file (assuming that we have accurately told it which columns contain which variable . . . ).

Often, we want to modify the variables in a dataset or create new variables.  The data we start out with here are “nominal” GDP, consumption, etc. and we would like to use “real” GDP, consumption, etc.  (That is, we want to put everything into 1987$).  To create new variables in a data step, just write the new variable name, an equals sign, and an expression to make the new variable.  To make real GDP out of nominal GDP, we want to multiply by 100 and divide by the GDP deflator (why?).  The line that creates the variable real GDP is:

          RealY = 100*Y/P;
There are several more similar lines in the program.  The next line of the data step is:

          inf = 100*(P-lag4(P))/lag4(P);
This line calculates the inflation rate.  P, recall, is the price index.  Remember that inflation is defined to be the % change in a price index in a year.  So,
inflation = 100*(price this quarter - price 1 year ago)/(price one year ago).  Since our data are in quarters, price one year ago is price 4 quarters ago (or price 4 observations ago).  SAS interprets the term lag4(P) as “P 4 observations ago” (similarly lag1(P) would mean “P one observation ago” and lag8(P) would mean “P 8 observations (2 years) ago”).  Make sure you understand this.  Similarly, if we wanted to calculate the growth rate of GDP over the past year:

          growth = 100*(RealY-lag4(RealY))/lag4(RealY);
This is the end of the data step in this program.

3.
Procedures

The procedures tell SAS what to do with the dataset you created in the data step.

Often, the first two procedures you will run will be proc contents and proc means:

        proc contents;

        proc means;

Proc contents causes SAS to print a summary of what variables are in your dataset.  The output from this procedure appears on page 8.  Proc means causes SAS to calculate the mean and several other statistics for each variable in your dataset.  The output from this procedure appears on page 9.

Since one of the main topics of this course is regression, we will often use proc reg, which is a regression procedure.  For proc reg, you need two lines (at least):

        proc reg;

          model RealI = RealY;

The first line, proc reg, tells SAS “I want you to run a regression”  The second line tells SAS exactly what regression to run.  In this case, you are telling SAS to run a regression based on the following model:





This says that real investment is a function of real GDP.  The output from this procedure appears on page 9.

4.
Etc.

After you are done with the procedures, you can go on to make new datasets and to run more procedures by starting a new data step, then going on to do more procedures, then starting a new data step, then going on to do more procedures, . . .

5..
This is the end

To ensure that your final procedure runs correctly, it is a good idea for the very last line of your program to be 

        run;

My first SAS program:
Please type, in the program editor, the program labeled “SAS EXAMPLE #1” (attached).  If you are feeling lazy, I included this program in the zip file; it should now be in your temp folder, named Example1.sas.  To get it click in the program editor window then go to the file menu and choose open.  Now hit the submit button (it is the guy running button, under the menu bar near the top of the window) --- alternatively, you can select “submit” from the Local menu right after you are done typing in the program.  SAS will “eat” the program from the program editor window; there will be a brief delay, and then (if everything has gone well) the output window will pop up with all of the results of all of your analyses in it.

Look over your analyses and make sure they are the same as on the attached output labeled “SAS EXAMPLE #1, OUTPUT”  Now, to clear out all that output (we want to do some more analyses) choose “clear text” from the edit menu.  All of the output will disappear.  Shrink the output window by clicking on the button in the upper right hand corner of the output window.

The LOG window, which is now visible contains information on what SAS did --- when you make errors programming, the LOG window is where SAS will tell you about them.

Now, let’s say we want to add some more analyses to our program.  Click in the program editor to select it.  Notice, your program is gone, and it would be a pain to type it in again.  Happily, you don’t have to:  just go to the Local menu and select “Recall text”  Now your program has reappeared.  Add more lines to your program so that it looks like “SAS EXAMPLE #2”.  Submit it again, and look at the output --- it should look like “SAS EXAMPLE #2, OUTPUT”

Suppose we are now happy with our analyses and output.  While we are looking at the output window, we can save our output by going to the File menu, Save As and selecting a file name.  Usually, SAS output files are saved with the suffix .lst (.lst for “list”).  So, a good name for our output would be first.lst.  When you are finished saving the program, clear text, shrink the output window, and activate the program editor by clicking in it.  Recall your program and save it also.  Usually, SAS program files are saved with the suffix .sas.  So, a good name for our program file would be first.sas.

Finally, quit SAS and fire up Microsoft Word, or your favorite word processor.  Open the two files first.lst and first.sas.  You will want to change the font of these files to SAS Monospace font (9 point) and you will want to reformat these files so that the lines do not “wrap around” --- often this will involve changing margins and using Landscape rather than Portrait orientation.  Also, you will need to put in page breaks to prevent the analyses from being split across pages.

A feature of SAS you may find useful is in the options menu.  While in SAS, and BEFORE you submit a program, go to the Globals menu and select Options;  a pop-up menu will appear; select Global Options from this menu.  Using the dialogue box that comes up, you can control how many characters per line SAS uses and how many lines per page.

Class auto example:
We did (or will do) an example in class involving the automobile dataset --- available on the web site.  You can download it (auto1.txt) along with an attached sas program --- the one I used in class.  Notice, in order to get the covariace matrix I used in class, I modified the proc reg slightly to tell SAS that I wanted the covariance matrix:


Proc reg;


model price = dom weight rel mpg / COVB;

The / COVB is how you ask SAS for the covariance matrix.

If you recall, our model was:


[image: image1.wmf]u

mpg

rel

weight

dom

price

+

+

+

+

+

=

5

4

3

2

1

b

b

b

b

b


And we were calculating the standard error of:



[image: image2.wmf]5

3

2

500

b

b

-


The calculation was a big pain.  Happily, SAS will automate these sorts of calculations.  The next command in that SAS program is also a regression command:

Proc glm;


model price = dom weight rel mpg;


estimate “w up 500 mpg dn 2” weight 500 mpg –2;

Proc glm is just another way of saying: “SAS I want you to run a regression.” The model statement tells SAS what regression to run.  The estimate statement tells SAS that you want to calculate an estimate and standard error for some equation involving the 
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.  You must then name your estimate --- I named it “w up 500 mpg dn 2”.  You also must tell SAS what to calculate.  Weight 500 says “multiply the coefficient on weight by 500”  mpg –2 says “multiply the coefficient on mpg by –2” Then SAS adds them up & reports an estimate and a standard error.  Run this program through SAS and then look at the last page of output.  You will see 2 parameter tables.  The lower one contains all the same parameters as before.  The upper one contains a parameter named “w up 500 mpg dn 2” (the name we gave it above).  There is an estimate, 1728 and a standard error, 234 --- identical to what we calculated in class, and much easier.  SAS does internally exactly the calculation which we did in class.

EXAMPLE #1
filename macroraw 'c:\temp\macro.txt';

data macro;

  infile macroraw;

  input year 1-4  quarter 10

        Y 14-20   C 24-30  I 34-40

        XM 44-50  G 54-60  P 64-68;

  RealY = 100*Y/P;

  RealC = 100*C/P;

  RealI = 100*I/P;

  RealXM = 100*XM/P;

  RealG = 100*G/P;

  inf = 100*(P-lag4(P))/lag4(P);

  growth = 100*(RealY-lag4(RealY))/lag4(RealY);

proc contents;

proc means;

proc reg;

  model RealI = RealY;

run;

EXAMPLE #1, OUTPUT
The SAS System                                        

                                                             11:44 Wednesday, February 11, 1998

                                      CONTENTS PROCEDURE

     Data Set Name: WORK.MACRO                                  Observations:         138

     Member Type:   DATA                                        Variables:            15

     Engine:        V612                                        Indexes:              0

     Created:       11:44 Wednesday, February 11, 1998          Observation Length:   120

     Last Modified: 11:44 Wednesday, February 11, 1998          Deleted Observations: 0

     Protection:                                                Compressed:           NO

     Data Set Type:                                             Sorted:               NO

     Label:

                          -----Engine/Host Dependent Information-----

                              Data Set Page Size:       8192

                              Number of Data Set Pages: 3

                              File Format:              607

                              First Data Page:          1

                              Max Obs per Page:         68

                              Obs in First Data Page:   49

                     -----Alphabetic List of Variables and Attributes-----

                              #    Variable    Type    Len    Pos

                             ƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒ

                              4    C           Num       8     24

                              7    G           Num       8     48

                             15    GROWTH      Num       8    112

                              5    I           Num       8     32

                             14    INF         Num       8    104

                              8    P           Num       8     56

                              2    QUARTER     Num       8      8

                             10    REALC       Num       8     72

                             13    REALG       Num       8     96

                             11    REALI       Num       8     80

                             12    REALXM      Num       8     88

                              9    REALY       Num       8     64

                              6    XM          Num       8     40

                              3    Y           Num       8     16

                              1    YEAR        Num       8      0

                                        The SAS System                                        

                                                             11:44 Wednesday, February 11, 1998

             Variable    N          Mean       Std Dev       Minimum       Maximum

             ---------------------------------------------------------------------

             YEAR      137       1974.88     9.9302311       1958.00       1992.00

             QUARTER   137     2.4963504     1.1188498     1.0000000     4.0000000

             Y         134       2294.74       1702.58   483.5000000       5898.60

             C         137       1483.40       1160.40   291.9000000       4053.90

             I         137   366.1321168   265.7183399    58.2000000   843.9000000

             XM        137   -27.3613139    44.3499789  -145.1000000    16.6000000

             G         137   432.4153285   319.2768598    94.6000000       1109.40

             P         137    59.0751825    31.2636436    25.4000000   120.6000000

             REALY     134       3387.45   906.0945600       1903.54       4904.62

             REALC     137       2177.12   656.7777486   986.1486486       3361.44

             REALI     137   547.2006329   164.3535043   196.6216216   806.8702290

             REALXM    137   -27.7973542    47.1397267  -145.6827309    34.0862423

             REALG     137   650.6916350   165.2842456   319.5945946   934.2783505

             INF       133     4.4622075     3.7133089   -13.7123746    10.8545035

             GROWTH    130     2.9154580     2.5101801    -3.2253644     8.0108601

             ---------------------------------------------------------------------

                                        The SAS System                                        

                                                             11:44 Wednesday, February 11, 1998

Model: MODEL1

Dependent Variable: REALI

                                     Analysis of Variance

                                        Sum of         Mean

               Source          DF      Squares       Square      F Value       Prob>F

               Model            1 2808934.0001 2808934.0001      698.223       0.0001

               Error          132 531032.80856   4022.97582

               C Total        133 3339966.8087

                   Root MSE      63.42693     R-square       0.8410

                   Dep Mean     554.57390     Adj R-sq       0.8398

                   C.V.          11.43706

                                      Parameter Estimates

                              Parameter      Standard    T for H0:

             Variable  DF      Estimate         Error   Parameter=0    Prob > |T|

             INTERCEP   1     11.267923   21.27870182         0.530        0.5973

             REALY      1      0.160388    0.00606980        26.424        0.0001

EXAMPLE #2
filename macroraw 'c:\temp\macro.txt';

data macro;

  infile macroraw;

  input year 1-4  quarter 10

        Y 14-20   C 24-30  I 34-40

        XM 44-50  G 54-60  P 64-68;

  RealY = 100*Y/P;

  RealC = 100*C/P;

  RealI = 100*I/P;

  RealXM = 100*XM/P;

  RealG = 100*G/P;

  inf = 100*(P-lag4(P))/lag4(P);

  growth = 100*(RealY-lag4(RealY))/lag4(RealY);

proc contents;

proc means;

proc reg;

  model RealI = RealY;

proc reg;

  model RealI = RealY growth;

  model RealI = RealY growth inf;

run;

EXAMPLE #2, OUTPUT
The SAS System                                        

                                                             11:44 Wednesday, February 11, 1998

                                      CONTENTS PROCEDURE

     Data Set Name: WORK.MACRO                                  Observations:         138

     Member Type:   DATA                                        Variables:            15

     Engine:        V612                                        Indexes:              0

     Created:       11:45 Wednesday, February 11, 1998          Observation Length:   120

     Last Modified: 11:45 Wednesday, February 11, 1998          Deleted Observations: 0

     Protection:                                                Compressed:           NO

     Data Set Type:                                             Sorted:               NO

     Label:

                          -----Engine/Host Dependent Information-----

                              Data Set Page Size:       8192

                              Number of Data Set Pages: 3

                              File Format:              607

                              First Data Page:          1

                              Max Obs per Page:         68

                              Obs in First Data Page:   49

                     -----Alphabetic List of Variables and Attributes-----

                              #    Variable    Type    Len    Pos

                             ƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒƒ

                              4    C           Num       8     24

                              7    G           Num       8     48

                             15    GROWTH      Num       8    112

                              5    I           Num       8     32

                             14    INF         Num       8    104

                              8    P           Num       8     56

                              2    QUARTER     Num       8      8

                             10    REALC       Num       8     72

                             13    REALG       Num       8     96

                             11    REALI       Num       8     80

                             12    REALXM      Num       8     88

                              9    REALY       Num       8     64

                              6    XM          Num       8     40

                              3    Y           Num       8     16

                              1    YEAR        Num       8      0

                                        The SAS System                                        

                                                             11:44 Wednesday, February 11, 1998

             Variable    N          Mean       Std Dev       Minimum       Maximum

             ---------------------------------------------------------------------

             YEAR      137       1974.88     9.9302311       1958.00       1992.00

             QUARTER   137     2.4963504     1.1188498     1.0000000     4.0000000

             Y         134       2294.74       1702.58   483.5000000       5898.60

             C         137       1483.40       1160.40   291.9000000       4053.90

             I         137   366.1321168   265.7183399    58.2000000   843.9000000

             XM        137   -27.3613139    44.3499789  -145.1000000    16.6000000

             G         137   432.4153285   319.2768598    94.6000000       1109.40

             P         137    59.0751825    31.2636436    25.4000000   120.6000000

             REALY     134       3387.45   906.0945600       1903.54       4904.62

             REALC     137       2177.12   656.7777486   986.1486486       3361.44

             REALI     137   547.2006329   164.3535043   196.6216216   806.8702290

             REALXM    137   -27.7973542    47.1397267  -145.6827309    34.0862423

             REALG     137   650.6916350   165.2842456   319.5945946   934.2783505

             INF       133     4.4622075     3.7133089   -13.7123746    10.8545035

             GROWTH    130     2.9154580     2.5101801    -3.2253644     8.0108601

             ---------------------------------------------------------------------

                                        The SAS System                                        

                                                             11:44 Wednesday, February 11, 1998

Model: MODEL1

Dependent Variable: REALI

                                     Analysis of Variance

                                        Sum of         Mean

               Source          DF      Squares       Square      F Value       Prob>F

               Model            1 2808934.0001 2808934.0001      698.223       0.0001

               Error          132 531032.80856   4022.97582

               C Total        133 3339966.8087

                   Root MSE      63.42693     R-square       0.8410

                   Dep Mean     554.57390     Adj R-sq       0.8398

                   C.V.          11.43706

                                      Parameter Estimates

                              Parameter      Standard    T for H0:

             Variable  DF      Estimate         Error   Parameter=0    Prob > |T|

             INTERCEP   1     11.267923   21.27870182         0.530        0.5973

             REALY      1      0.160388    0.00606980        26.424        0.0001

                                        The SAS System                                        

                                                             11:44 Wednesday, February 11, 1998

Model: MODEL1

Dependent Variable: REALI

                                     Analysis of Variance

                                        Sum of         Mean

               Source          DF      Squares       Square      F Value       Prob>F

               Model            2 2664556.6567 1332278.3283      399.853       0.0001

               Error          127 423153.81032   3331.91977

               C Total        129  3087710.467

                   Root MSE      57.72278     R-square       0.8630

                   Dep Mean     562.17884     Adj R-sq       0.8608

                   C.V.          10.26769

                                      Parameter Estimates

                              Parameter      Standard    T for H0:

             Variable  DF      Estimate         Error   Parameter=0    Prob > |T|

             INTERCEP   1    -48.113929   23.20330140        -2.074        0.0401

             REALY      1      0.167770    0.00593837        28.252        0.0001

             GROWTH     1     11.815951    2.08721188         5.661        0.0001

                                        The SAS System                                        

                                                             11:44 Wednesday, February 11, 1998

Model: MODEL2

Dependent Variable: REALI

                                     Analysis of Variance

                                        Sum of         Mean

               Source          DF      Squares       Square      F Value       Prob>F

               Model            3 2830400.0013 943466.66711      461.998       0.0001

               Error          126 257310.46568   2042.14655

               C Total        129  3087710.467

                   Root MSE      45.19012     R-square       0.9167

                   Dep Mean     562.17884     Adj R-sq       0.9147

                   C.V.           8.03839

                                      Parameter Estimates

                              Parameter      Standard    T for H0:

             Variable  DF      Estimate         Error   Parameter=0    Prob > |T|

             INTERCEP   1   -109.646725   19.40635174        -5.650        0.0001

             REALY      1      0.159433    0.00474019        33.634        0.0001

             GROWTH     1     16.754458    1.72348611         9.721        0.0001

             INF        1     15.528066    1.72310521         9.012        0.0001

_980079463.unknown

_980079527.unknown

_980079746.unknown

_948630621.unknown

